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GroupWise and Daylight Saving Time

This document briefly explains the concepts of world time zones and the 
application of Daylight Saving Time, how DST is handled with different 
versions of GroupWise® (4.x and 5.x), and ways to recognize and correct 
possible DST problems in GroupWise.
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1 Checking for Daylight Saving Time 
Readiness

If you have already encountered problems with appointment times or message 
time stamps, it is probable that your GroupWise® system will have difficulty 
with Daylight Saving Time (DST) changes. To help you resolve these 
difficulties, see Chapter 2, �Concepts, Issues, and Solutions,� on page 19.

If you are running a total GroupWise 4.1 system without difficulty, you must 
remember to manually update DST dates at GroupWise 4.x sites a week after 
DST begins and again a week after DST ends. This must be done every year. 
You should also review �Other Important GroupWise 4.x Daylight Saving 
Time Facts� on page 23.

If you are not sure whether your 5.0, 5.1, or 5.2 GroupWise system will have 
DST difficulties, and if your system includes versions (including 4.1 versions) 
of the clients, agents, post offices, or domains that predate the GroupWise 5.2 
Support Pack 3 (released April 15, 1998), you should determine whether the 
observance of DST will affect message time stamps or appointments that have 
been set to occur while DST is in effect. The �DST Transition Worksheet� on 
page 17 helps you to record the information you find as you perform this DST 
readiness check. The readiness check consists of the following tasks: 

! �Checking the Version of Your GroupWise Snap-In� on page 10 

! �Checking the Version of Your GroupWise Clients� on page 11 

! �Checking the Domain Time Settings� on page 12 

! �Checking the Post Office Time Settings� on page 14 

The information in this section will refer you to information that can help you 
resolve potential DST problems. 
Checking for Daylight Saving Time Readiness 9
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Checking the Version of Your GroupWise Snap-In 
When GroupWise is installed, a group of dynamic link libraries (DLLs) is 
"snapped in" to NetWare® Administrator, making it possible to administer 
GroupWise and the network from a central location. Different versions of 
GroupWise have used different snap-ins, and as GroupWise has evolved, its 
ability to handle the dynamics of worldwide Daylight Saving Time and 
reconciling those dynamics with GroupWise appointments has improved. 

Earlier versions of the snap-in were 16-bit enabled only. They used an 
absolute method of calculating time stamps and appointment times based on 
time settings entered by the administrator during installation or in earlier 
versions (5.0 and 5.1) of the GroupWise Administration program. You can 
confirm that you have an early version of the snap-in if you find 
GWADMA3X.DLL in the \PUBLIC directory from where you run NetWare 
Administrator. If your GroupWise system uses the GWADMA3X.DLL, it 
also uses absolute values for calculating appointment times. 

Later versions (beginning with 5.2) of the snap-in were 32-bit enabled. You 
can confirm that you have a later version of the snap-in if you find 
GWADMA32.DLL in the \PUBLIC\WIN95 directory, the \PUBLIC\WINNT 
directory, or the \PUBLIC\WIN32 directory from where you run NetWare 
Administrator. At first, the GWADMA32.DLL snap-in continued to use the 
absolute value calculation method, but was later enhanced to use a formula for 
performing calculations for appointment times. The formulaic method does a 
better job of accounting for Time Zone and Daylight Saving Time differences 
when appointments are scheduled far in advance or across time zones. The 
following table summarizes the characteristics of the GroupWise 5.2 snap-in:

Release Date Formula-based Calculation or Absolute 
Value Calculation

earlier than 7/24/97 Absolute

7/24/97 Formula - incomplete

12/22/97 Formula - incomplete

4/15/98 Formula

later than 4/15/98  Formula 
10 GroupWise and Daylight Saving Time
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Knowing the version of the GroupWise snap-in that you use to administer 
GroupWise will tell you whether your system has been patched to implement 
the formula-based method of calculation. 

If the GWADMA32.DLL you are using is dated prior to 4/15/98, you must 
apply GroupWise 5.2 Support Pack 3 (SP3) before you can resolve any DST 
issues. For more information about SP3, see Appendix C, �GroupWise 5.2 
Support Pack 3,� on page 51. When you have applied SP3, you may continue 
checking DST readiness by referring to �Checking the Version of Your 
GroupWise Clients� on page 11.

Continue with the other tasks in this section to check for possible DST 
conflicts and the methods you should use to resolve them. 

Checking the Version of Your GroupWise Clients
Because messages and appointments originate at an individual user�s 
GroupWise client program, the client itself is responsible for assigning times 
to these messages and appointments. The method that the GroupWise client 
uses for calculating appointment times has continued to evolve, just as the 
GroupWise snap-in DLL evolved its calculation method from using absolute 
values to using a formula. The following table lists GroupWise client types, 
their release dates, and their calculation methods. 

WORKSHEET

Under Item 1: GroupWise Snap-In Data, enter the snap-in name, release date, 
and appointment calculation method. 

Make sure you check every server from which you run NetWare Administrator.

Client Type Release Date Formula-Based Calculation 
or Absolute Value 
Calculation

4.1, 16-bit All dates Absolute

5.0, 16- bit or 32-bit All dates Absolute

5.1, 16- bit or 32-bit All dates Absolute

5.2, 16-bit 7/24/97 Absolute
Checking for Daylight Saving Time Readiness 11
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Knowing whether a client uses an absolute or formula-based calculation 
method will help you to know whether you should continue your readiness 
check. To check the client version and release date from the client program, 
open the GroupWise client > click Help > About GroupWise. 

If you have any clients that use the absolute calculation method, you need to 
investigate to see if the different time settings in the GroupWise system match 
with the local time settings established for each time zone. If the settings do 
not currently match, you can take the corrective action appropriate for your 
circumstances. For more information about checking GroupWise system time 
settings, see �Checking the Domain Time Settings� on page 12 and �Checking 
the Post Office Time Settings� on page 14.

Checking the Domain Time Settings 
The GroupWise client relies on time zone settings in its system to calculate 
appointments. The time zones can be defined at the domain or post office 

5.2, 32-bit 7/24/97 Formula

5.22, 16-bit 12/22/97 Absolute

5.22, 32-bit 12/22/97 Formula

5.23, 16-bit 4/15/98 Formula

5.23, 32-bit 4/15/98 Formula

All Versions Later than 4/15/98 Formula

WORKSHEET

Under Item 2: GroupWise Client Data, enter the client type, release date, and 
appointment calculation method.

Check all locations where the client is installed and list the versions and release 
dates of the GroupWise client that are running on this domain. If you think there 
is a chance that a user may not be using the client you provided, you can have 
each user report his or her own client version and release date.

Client Type Release Date Formula-Based Calculation 
or Absolute Value 
Calculation
12 GroupWise and Daylight Saving Time
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level. If the local time zone values (that is, the actual time zone values), the 
time zone values set in GroupWise administration, and the values listed in the 
time zone database record do not match, you must take corrective action. 

An administrator manually configures the time zone settings for a domain 
during installation or subsequent configuration by using the GroupWise 4.1 
administration program (AD.EXE) or NetWare Administrator. Because the 
settings may not be correct, you should check them with standard settings in 
the time zone where the domain resides. 

The time zone settings for a domain are also listed in the time zone record of 
the domain database. You can check these values by using the GroupWise 
Diagnostics menu in NetWare Administrator. For more information, see 
Appendix B, �The GroupWise Diagnostics Menu and Time Zone Settings,� on 
page 41. 

Compare the data in worksheet item 3, worksheet item 4, and worksheet item 
5. You must determine whether the values match or do not match, then you 
must follow procedures based on this comparison. Do not continue with the 
rest of the section until you have followed these procedures. 

WORKSHEET

Under Item 3: Domain�s Local Time Settings, enter the name of the domain�s 
time zone, its GMT offset, and the amount of DST offset, if any.

WORKSHEET

Under Item 4: Domain�s Configured Time Settings, enter the time setting details 
of the GroupWise domain object, including time zone name, GMT offset, and the 
amount of DST offset, if any. Use AD.EXE or NetWare Administrator to obtain 
these values. 

WORKSHEET

Under Item 5: Domain�s Time Zone Record Settings, enter the time setting 
details of the GroupWise domain object, including time zone name, GMT offset, 
and the amount of DST offset, if any. Use the GroupWise Diagnostics menu 
under Tools in NetWare Administrator to obtain these values.
Checking for Daylight Saving Time Readiness 13
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If the Domain Time Values Match
If the domain time values match, you are ready to check the post office time 
settings. If you are still using GroupWise 4.1 in some domains, you should: 

! Remember to manually update DST dates at GroupWise 4.x sites a week 
after DST begins and again a week after DST ends. This must be done 
every year. 

! Review �Other Important GroupWise 4.x Daylight Saving Time Facts� 
on page 23. 

If the Domain Time Values Do Not Match
If the domain time values do not match or are inaccurate, you must follow 
specific procedures to resolve the problem. The procedure you use depends on 
whether you are using GroupWise 4x domains or GroupWise 5.x domains. 

GroupWise 4.x Domains

Use procedures outlined in �Resolving 4.x DST Problems� on page 23.

GroupWise 5.x Domains

Use procedures outlined in �Troubleshooting and Resolving 5.x DST 
Problems� on page 28. 

Checking the Post Office Time Settings
The GroupWise client relies on time zone settings in its system to calculate 
appointments. The time zones can be defined at the domain or post office 
level. If the local time zone values (that is, the actual time zone values), the 
time zone values set in GroupWise administration, and the values listed in the 
time zone database record do not match, you must take corrective action. 

WORKSHEET

Under Item 6: All Post Offices and Their Local Time Settings, enter the name of 
each post office in this domain, its GMT offset, and the amount of DST offset, if 
any.
14 GroupWise and Daylight Saving Time
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An administrator manually configures the time zone settings for a post office 
during installation or subsequent configuration using AD.EXE or NetWare 
Administrator. Because the settings may not be correct, you should check 
them with the standard settings of the time zone where the domain resides. 

The time zone settings for a domain are also listed in the time zone record of 
the domain database. You can check these values by using the GroupWise 
Diagnostics program. For more information about using the program see 
Appendix B, �The GroupWise Diagnostics Menu and Time Zone Settings,� on 
page 41.

Compare the data in worksheet item 6, worksheet item 7, and worksheet item 
8. You must determine whether the time values for the post office either match 
or do not match. You can take steps based on this comparison. 

If the Post Office Time Values Match 
If the post office time values match, you should be ready for implementing 
Daylight Saving Time without making major adjustments. If you want more 
information about Daylight Saving Time in the GroupWise environment, see 
Chapter 2, �Concepts, Issues, and Solutions,� on page 19. 

If the Post Office Time Values Do Not Match
If the post office time values do not match or are inaccurate, you must follow 
specific procedures to resolve the problem. The procedure you use depends on 
whether you are using GroupWise 4.x or GroupWise 5.x. 

WORKSHEET

Under Item 7: Configured Time Settings of Each Post Office, enter the time 
setting details of each GroupWise post office object, including time zone name, 
GMT offset, and the amount of DST offset, if any. Use AD.EXE or NetWare 
Administrator to obtain these values.

WORKSHEET

Under Item 8: Time Zone Record Settings of Each Post Office, enter the time 
setting details of the GroupWise post office object, including time zone name, 
GMT offset, and the amount of DST offset, if any. Use the GroupWise 
Diagnostics menu under Tools in NetWare Administrator to obtain these values.
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GroupWise 4.x

If the time values do not match in your GroupWise 4.x post offices, use the 
procedures outlined in �DST Issues in GroupWise 4.x� on page 22. 

GroupWise 5.x

If the time values do not match in your GroupWise 5.x post offices, use the 
procedures outlined in �Troubleshooting and Resolving 5.x DST Problems� 
on page 28.

Note that correcting a DST problem may bring it to the attention of users who 
didn�t realize any problems existed in GroupWise. To learn about the optimal 
time to correct DST problems and leave GroupWise users unaffected, see 
�When to Correct DST Problems� on page 34.
16 GroupWise and Daylight Saving Time
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DST Transition Worksheet
Complete a copy of the following worksheet for each domain in your 
GroupWise system if you are running any GroupWise 4.1, 5.0, 5.1 or 5.2 
components in that system. 

GroupWise Domain 
Name:________________________________________ 

Item Example Explanation

1) GroupWise Snap-In 
Data: 

GWADMA32.DLL 
07/24/97 
Formula - incomplete 

5.0, 5.1: Record the release date of the 
GWADMA3X.DLL that is installed in the \PUBLIC 
directory of the workstation where you run 
NetWare Administrator. 

5.2: Record the release date of the 
GWADMA32.DLL that is installed in the 
\PUBLIC\WIN95 directory, the \PUBLIC\WINNT 
directory, or the \PUBLIC\WIN32 directory of 
every server from which you run NetWare 
Administrator.

2) GroupWise Client 
Data: 

5.2 16-bit 

! 07/24/97

!  Absolute 

5.2 32-bit 

! 07/24/97 

! Formula 

Record all of the different client types running on 
your system, the release date of each type and 
the appointment calculation method of that type.

3) Domain�s Local Time 
Settings:

Arizona - MST (GMT-7)
DST Offset = Not 
observed

Record the name of the time zone, its GMT 
offset, and the amount of DST offset, if any. 

4) Domain�s Configured 
Time Settings: 

MST (GMT-7) 
DST Offset=None

Check the time setting details of the GroupWise 
domain object by using AD.EXE or NetWare 
Administrator.

5) Domain�s Time Zone 
Record Settings:

MST (GMT-7) 
DST Offset=0 minutes

Use GroupWise Diagnostics to check the record 
information for this time zone. For more 
information, see Appendix B, �The GroupWise 
Diagnostics Menu and Time Zone Settings,� on 
page 41. 
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6) All Post Offices and 
Their Local Time 
Settings:

Sales 
MST (GMT-7) 
DST = +1 
Service 
MST (GMT-7)
DST = +1 
Purchasing 
MST (GMT-7) 
DST = 0

Record the name of each post office in this 
domain, its local time zone, its GMT offset, and 
the amount of DST offset, if any.

7) Configured Time 
Settings of Each Post 
Office:

Sales 
MST (GMT-7) 
DST = +1 
Service 
MST (GMT-7)
DST = +1 
Purchasing 
MST (GMT-7) 
DST = 0 

Check the time setting details of each 
GroupWise post office object by using AD.EXE 
or NetWare Administrator.

8) Time Zone Record 
Settings of Each Post 
Office: 

Sales 
MST (GMT-7) 
DST = 3600 
Service 
MST (GMT-7) 
DST = 3600 
Purchasing 
MST (GMT-7) 
DST = 0 

Use GroupWise Diagnostics to check the record 
information for this time zone. For more 
information, see Appendix B, �The GroupWise 
Diagnostics Menu and Time Zone Settings,� on 
page 41. 

Item Example Explanation
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2 Concepts, Issues, and Solutions

GroupWise® has always been carefully designed to recognize a basic 
principle of electronic communication: time is relative to the location where 
that communication may occur. Although the time of day varies throughout 
the world at any given moment, a responsible network messaging system will 
reconcile those differences in message time stamps and scheduled 
appointments. The more widespread the communication, the greater the 
responsibility of the messaging technology to keep the communication 
synchronized and useful to those who must deal with time differences. 

With this premise in mind, GroupWise engineers designed GroupWise to 
account for and synchronize messages not only by using the finite standards 
of the defined world time zones, but also by using the more unevenly applied 
standard known as Daylight Saving Time (DST). 

The purpose of this document is to briefly explain the concepts of world time 
zones and the application of DST, how DST is handled with different versions 
of GroupWise (4.x and 5.x), and ways to recognize and correct possible DST 
problems in GroupWise. The information is included in the following 
sections: 

! �Time Zone and Daylight Saving Time Concepts� on page 20 

! �Recognizing DST Issues in Versions of GroupWise� on page 21 

! �Troubleshooting and Resolving 5.x DST Problems� on page 28 

! �When to Correct DST Problems� on page 34 
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Time Zone and Daylight Saving Time Concepts

Understanding Time Zones 
The earth�s rotation from daylight to darkness and the need for constant 
communication between different locations in the world make it necessary to 
establish a system for measuring time based on a single standard. This 
standard, called Coordinated Universal Time (UTC) is a measurement of 
mean solar time beginning at a defined longitude on the earth (0 -- the prime 
meridian). From this longitude, traveling both east and west, timekeepers 
divide the earth into 24 increments of 15 longitude each. Each of these 
increments represents a different "standard" time zone and is numbered 
relative to the prime meridian by adding or subtracting one hour. Thus each 
time zone is referred to by its "offset" from UTC, so the world time zones are 
designated from -12 through 0 (UTC) to +12. UTC time designations can also 
be referred to as Greenwich Mean Time (GMT), so named because authorities 
at the Greenwich observatory in England established it as the location of the 
prime meridian. 

Understanding Daylight Saving Time
Daylight Saving Time is the system of setting clocks one or two hours ahead 
of standard time so that both sunrise and sunset occur at a later hour, thus 
artificially moving a period of daylight to the evening hours. For example, in 
the northern hemisphere, clocks are usually set ahead one hour in the spring 
and set back to standard time in the fall. When DST is in effect in the southern 
hemisphere it will not be in effect in the northern hemisphere, and vice versa. 
Daylight Saving can be considered a political system, rather than a scientific 
one, because national and regional governments decide whether they will 
adopt the system or not. In some time zones, DST may not be used at all. 
Governments or institutions may define the DST starting and ending dates 
years in advance, but they may also change these dates at any time. For 
example, in 1996, most of Europe adopted a new DST standard end date 
setting of the last Sunday of October. Many of the countries agreeing to the 
change had formerly ended DST on the last Sunday of September. Because of 
the lack of consistent DST adoption by the world�s governments, the total 
number of times-of-day within all time zones adds up to about 50. 
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Recognizing DST Issues in Versions of GroupWise 
The constant variability in the adoption of Daylight Saving Time, the 
improving technology and design of GroupWise, and the need for backward 
compatibility have uncovered some important issues regarding GroupWise 
and DST. 

Because different versions of GroupWise deal with DST configuration in 
different ways, and because worldwide DST is now implemented differently 
than it was when older versions of GroupWise were designed, you may see 
evidence that GroupWise is not handling time-related information correctly. 
Your users may report any of the following problems: 

! Meetings are scheduled to start one hour earlier or later than the sender 
specified. 

! Incoming messages show an incorrect delivery time. 

! Status of outgoing messages shows incorrect send or receive times. 

These symptoms are a result of DST start and end dates being incorrectly 
calculated. Most commonly, this occurs because: 

! The 5.x system or part of the 5.x system was migrated from GroupWise 
4.1 with GroupWise 5.2 Support Pack 2 or earlier code. 

! The original 4.1 system that was migrated to 5.x did not use Daylight 
Saving Time (that is, the DST clock change settings for the affected time 
zones were set at 0). For more information about this scenario, see �DST 
Reactivated in a 5.x System Migrated From 4.1� on page 25.

! Some of the post offices (either in 4.x or 5.x systems) used incorrect DST 
settings. 

This section of the document discusses the most common GroupWise DST 
issues and offers possible solutions. The information is organized according 
to the version of GroupWise you have. 

! �DST Issues in GroupWise 4.x� on page 22

! �DST Issues in GroupWise 5.x� on page 24 

This section also includes information about rarely-occurring circumstances 
that can cause DST miscalculation in GroupWise. For more information, see 
�Unusual DST Problems� on page 26.
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DST Issues in GroupWise 4.x
In GroupWise 4.1, appointments are "stored" and "displayed" relative to 
Greenwich Mean Time. The relationship between the appointment time and 
GMT is expressed as an "offset" from GMT. The offset is directly affected by 
the domain and post office time zone and Daylight Saving Time settings you 
configure in the GroupWise 4.1 administration program, AD.EXE. 

If you make changes to these settings while the GroupWise system is in use, 
those changes are replicated throughout the system. For example, if you 
change the DST offset after an appointment has already been "stored," that 
appointment will be "displayed" using a different offset than was in effect 
when it was "stored." Because of this, the following precautions are 
recommended: 

! Always change the DST settings, including offset, beginning date, and 
ending date, well before the time when users may set appointments to 
occur inside the DST observance period. If some advance appointments 
are already set to occur during that period, all such appointments will be 
"bumped" by one hour. 

! Always be sure of the DST observance or non-observance at every 
physical location where a GroupWise 4.1 domain or post office resides. 
If one of these objects is physically located in an area that does not 
implement DST, while other objects in the same GroupWise system are 
physically located in areas that do implement DST, the non-DST object 
must not be assigned the same time zone as the DST objects. If all objects 
are assigned the same time zone, AD.EXE assumes that DST settings 
apply to all objects which share the same time zone, and so it replicates 
DST settings throughout the system. Obviously, this makes the 
appointments in non-DST user mailboxes inaccurate. 

Example

The state of Arizona does not observe DST. From a DST point of view, 
Arizona is logically located in Mountain Standard Time for part of the year, 
and Pacific Daylight Time for the remainder of the year. 

If a company had domains in Los Angeles, Phoenix, and Denver, the 
administrator would assign a different time zone for each domain, making sure 
that the DST setting was correct for each time zone. Then, in January, a user 
in Los Angeles could schedule users in Phoenix and Denver for a July 
conference call and all participants would display that appointment at the 
appropriate time. However, if the administrator assigned the same time zone 
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to the Phoenix domain as the Denver domain, or to the same time zone as the 
Los Angeles domain, the move to DST would bump all Phoenix domain 
appointments previously scheduled during DST. 

It is possible that the DST setting for a 4.x domain and the DST setting for a 
4.1 post office may not be the same, even when they share the same time zone. 
If this condition exists and appointments have already been set, correcting the 
DST offset at a domain incorrectly bumps appointments in all other domains 
in that time zone. This may occur if routine database synchronization is 
interrupted, such as when the GroupWise 4.x Administration Server is not 
running or the target database is damaged. 

Resolving 4.x DST Problems

 If you detect a DST synchronization problem after appointments have been 
scheduled to occur during DST observance, there are three solutions: 

! Remove the offset that originally caused the appointments to be bumped. 
This solution corrects the display problems within the domain but leaves 
the domain�s DST setting unsynchronized with the rest of the system. 

! Reschedule the appointments. This may be difficult if the start and end 
dates of DST will change for the coming year. For GroupWise 4.1 user 
instructions for using the client to locate sent appointments, see Appendix 
F, �Rescheduling Multiple Outbound Appointments,� on page 69.

! Run the GroupWise 4.x Appointment Time Adjuster to modify the 
appointments in a 4.x post office. For more information, see Appendix D, 
�GroupWise 4.x Appointment Time Adjuster,� on page 57.

Other Important GroupWise 4.x Daylight Saving Time Facts

There are a few other Daylight Saving Time facts that GroupWise 4.1 
administrators should be aware of: 

! If you schedule an appointment on the day (and possibly the day after) 
that DST goes into effect, that appointment will be stored correctly but 
displayed incorrectly. There will be a one hour difference. This is a 
GroupWise 4.x architectural limitation and cannot be corrected. 

! GroupWise 4.x does not allow DST offsets of less than 1 hour (as 
allowed, for example, in Newfoundland). This is a GroupWise 4.x 
architectural limitation and cannot be fixed.
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!  Remember to change the DST begin date and the Standard Time begin 
date for DST-affected time zones in GroupWise 4.1 as the calendar dates 
change each year for these settings. 

The GroupWise 4.x Appointment Time Adjuster can help you modify 
existing, future appointments residing in GroupWise 4.x post offices. For 
more information about this tool, see Appendix D, �GroupWise 4.x 
Appointment Time Adjuster,� on page 57.

DST Issues in GroupWise 5.x
Although improvements have been made in GroupWise 5.x with regard to 
Daylight Saving Time, some issues still exist if newer GroupWise 5.x code 
communicates with 4.x or older 5.x code. This section discusses some of the 
causes of DST problems in GroupWise 5.x, including the specific problems 
that occur when DST is reactivated in a 5.x system migrated from 4.1. 

General Causes of DST Problems

Prior to the release of GroupWise 5.2, time zone information (that is, local 
UTC) had to be defined for domains and post offices using absolute, preset 
dates for Daylight Saving Time changes. Later, when the GroupWise 5.2 32-
bit client was introduced, a more robust, formula-based DST definition was 
implemented (for more information about this method, see Appendix A, 
�GroupWise Appointment Time Calculation,� on page 37).

Still later, with the release of GroupWise 5.2 Support Pack 3 (SP3), this 
formula-based definition was extended to all GroupWise 5.2 components 
(including the 16-bit client). To maintain backward compatibility and version 
connectivity, GroupWise 5.2 domain and post office databases were also 
designed to store GroupWise 4.x post office and gateway time zone definitions 
that continue to use absolute DST information. 

These differences in time zone reckoning can be represented in two groups: 

Group A:

The "absolute date" time zone configuration group, which includes: 

! All GroupWise 4.x components 

! All GroupWise 5.0 components 

! All GroupWise 5.1 components 

! The GroupWise 5.2 16-bit client released prior to SP3 
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IMPORTANT: If you previously elected to disable DST or to edit a Time Zone 
definition in GroupWise 4.x, these settings will be lost during a migration to 
GroupWise 5.2. You can easily restore the settings if SP3 has been applied.

Group B:

The "formula-based" time configuration group, which includes: 

! The GroupWise 5.2 32-bit client 

! The GroupWise 5.2 16-bit client (after SP3 has been applied) 

! The GroupWise 5.5 16-bit client 

! The GroupWise 5.5 32-bit client 

If these two component groups communicate using the same GroupWise 
systems, (usually after a 4.1 migration) symptoms of incorrect DST 
information sharing may occur, including: 

! Differences in appointment times between 5.x and 4.x users 

! Incorrect time stamps on messages processed by gateways 

! Incorrect DST start and end dates for 4.x users. 

DST Reactivated in a 5.x System Migrated From 4.1

If you are experiencing appointment synchronization problems in a 
GroupWise system that was recently migrated to GroupWise 5.x from 
GroupWise 4.1, it may be because the administrator of the 4.1 system set the 
DST clock change settings of particular time zone to zero. This deactivates the 
observance of DST in that time zone by GroupWise 4.1. However, when the 
GroupWise 4.1 system is migrated, GroupWise 5.2 (with SP3) or GroupWise 
5.5 apply their own default time zone definitions to domains and post offices, 
so DST is reactivated. In this way, depending on the time of year you migrate 
your post offices and the scheduled dates of the appointments in those post 
offices, appointment times will be incorrect: 

! If you migrate a post office while DST is in effect for a DST time zone, 
the appointments for users in that time zone are moved forward one hour 
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on the GroupWise Calendar. For example, an appointment scheduled for 
2:00 p.m. is moved to 3:00 p.m. 

! If you migrate a post office while DST is not in effect for a DST time 
zone, the appointments for users in that time zone scheduled to occur 
when DST is in effect are also be moved forward one hour on the 
GroupWise Calendar. Appointments scheduled to occur during non-DST 
are unaffected. 

For more information about adjusting the appointment times that were 
changed during migration to GroupWise 5.2 (with SP3 applied) or to 
GroupWise 5.5, see �Rechecking the Appointment Times� on page 32.

If the GroupWise 4.1 system was migrated to a GroupWise 5.x system before 
SP3 was applied, you may have manually deactivated DST settings in order to 
avoid appointment synchronization problems. If you apply SP3 to the system 
now, you can reactivate DST for the post offices in time zones where it had 
been deactivated. After you apply SP3 and correct the DST settings, perform 
the following tasks on a day when DST is no longer in effect: 

! Run the GroupWise 5.x Appointment Time Adjuster on each 5.x post 
office to move all appointments between April 5 and October 25, 1998 to 
one hour earlier. 

! Run the GroupWise 5.x Appointment Time Adjuster on each 5.x post 
office to move all appointments occurring during the 1999 DST 
observance to one hour earlier.

! Run the GroupWise 5.x Appointment Time Adjuster on each 5.x post 
office to move all appointments occurring during the 2000 DST 
observance to one hour earlier. 

Unusual DST Problems
There are also at least two highly unusual circumstances which, when 
combined with Daylight Saving Time and GroupWise 4.1 migration, cause 
incorrect DST calculation. 

! Newfoundland, Canada and DST. This problem occurs when 
appointments are sent from or received at Newfoundland, Canada. 

! Beep On Error Set in GroupWise 4.1. This problem occurs when a certain 
GroupWise 4.1 system environment option is set up. 
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Newfoundland, Canada and DST

You may notice that appointments sent to the Newfoundland time zone (NFT) 
from another time zone are scheduled 4 hours, 16 minutes late when DST is 
not in effect or 3 hours late when DST is in effect. Appointments received 
from NFT are scheduled 4 hours early when DST is not in effect or 3 hours 
early when DST is in effect. 

This problem affects any time zone that is designated with a negative GMT 
offset and uses a DST change of less than 60 minutes. The Newfoundland time 
zone is currently the only time zone that meets these criteria. 

You can correct the NFT problem by applying GroupWise 5.2 Support Pack 
3. However, if you are a GroupWise system administrator residing in 
Newfoundland, you will need to use the GroupWise 5.x Appointment Time 
Adjuster before you apply Support Pack 3. Use the adjuster to modify future 
appointments scheduled outside of Newfoundland. For more information 
about the GroupWise Support Pack 3, see. Appendix C, �GroupWise 5.2 
Support Pack 3,� on page 51. For more information about the GroupWise 5.x 
Appointment Time Adjuster, see Appendix E, �GroupWise 5.x Appointment 
Time Adjuster,� on page 63.

Beep On Error Set in GroupWise 4.1

In GroupWise 4.1, the system administrator has the option of setting the 
administrative environment options. This is done by selecting File > Setup > 
Environment. One of the options, Beep On Errors, can be locked so that 4.1 
client users will always receive a beep if an error is detected. 

In GroupWise 5.x, this particular environment setup option was not 
implemented, but the code record for the option was reused for 5.x DST 
calculation. This means that if a 4.1 system with this locked record left intact 
is migrated to GroupWise 5.1 or GroupWise 5.2 (prior to Support Pack 3), the 
time zone record is migrated to 5.x DST calculation methods, but it cannot be 
unlocked. The end result is an inability to correct DST settings from a 
migrated 4.1 system. 

To correct the problem, you should make sure that you apply the GroupWise 
Support Pack 3 to the 5.x system you are using during the migration. After you 
do this, you can change or adjust the DST settings as necessary. For more 
information about GroupWise Support Pack 3, see �Obtaining and Applying 
the GroupWise 5.2 Support Pack 3� on page 52.
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Troubleshooting and Resolving 5.x DST Problems
If you suspect that Daylight Saving Time synchronization is the cause of 
incorrect appointments in your users� mailboxes, you need to troubleshoot in 
order to find the best way to correct the problem. The flowchart or "decision 
tree" diagram below will help you decide which troubleshooting strategy you 
can take to remedy these symptoms at your 5.x primary domain. 

! �Using the GroupWise Diagnostics Menu to Check DST Settings� on 
page 28

! �DST Values Are Correct� on page 29

! �DST Values Are Not Correct� on page 30

! �Rechecking the Appointment Times� on page 32

Using the GroupWise Diagnostics Menu to Check DST Settings 
The GroupWise 4.x, 5.0, and 5.2 16-bit clients depend on the Daylight Saving 
Time settings made in AD.EXE or in NetWare® Administrator and saved in 
the domain database. The settings are made when you install or create a new 
domain or post office, or you can change them with the Time Zone 
configuration tool found in GroupWise System Operations. 

"Use the GroupWise 
Diagnostics Menu to 
Check DST Settings"

Follow Procedures

"DST Values Are 
Correct"

Follow Procedures

DST appointment
problems are resolved

A

Yes

No "DST Values
Are Not Correct"

Follow Procedures

Yes

A

No

"Recheck the 
Appointment Times"

Follow Procedures

Are the
settings correct?

Are the
appointment

times
correct?

DST appointment
problems

after 4.1 migraation
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The settings required for DST adjustment vary according to the version of 
GroupWise. If you have migrated part or all of your GroupWise 5.x system 
from GroupWise 4.x, the only way to check all of the current stored DST 
values in a domain database is by using the GroupWise Diagnostics menu, 
which adds diagnostic functionality to the GroupWise DLLs "snapped in" to 
NetWare Administrator during a GroupWise 5.x installation. Although this 
tool is also included in the installation, it is not readily available (or visible) 
until you add its string value to the Windows* Registry. 

When you enable the GroupWise Diagnostics menu, you can check a time 
zone record stored in a domain database to see if the current values for its 
Daylight Saving Time settings are correct. For details about enabling the 
menu and checking these values, see Appendix B, �The GroupWise 
Diagnostics Menu and Time Zone Settings,� on page 41. 

After you use the GroupWise Diagnostics menu to check the settings, you 
should be able to determine whether these settings are correct or incorrect. 

DST Values Are Correct

If the DST values appear to be correct when you view them using the 
GroupWise Diagnostics menu and your users are experiencing appointment 
problems or their messages have an incorrect delivery time stamp, Daylight 
Saving Time has probably been configured incorrectly at some domain or post 
office. 

To correct the misconfiguration, use the Time Zone configuration tool to 
check the following: 

! Each Time Zone assigned to a domain or post office in your system must 
be set to the correct GMT offset. 

! The Daylight Saving Time begin and end dates must be set correctly for 
each time zone used by a domain or post office in your system. 

! The file server where a domain, a post office, a gateway, or an agent is 
operating must be configured with the correct time and DST settings. 

For more information about configuring a time zone in GroupWise 5.2, see 
Chapter 4, "Customize Time Zones", in Book 3 of the GroupWise 5.2 
Maintenance Guide. (http://www.novell.com/groupwise/administration/
gw52/us/mbook31.html) 
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DST Values Are Not Correct

If the DST values appear to be incorrect when you view them using the 
GroupWise Diagnostics menu and your users are experiencing appointment 
problems or their messages have an incorrect delivery time stamp, you should 
do two things: 

! Apply the GroupWise 5.2 Support Pack 3. See �Applying the GroupWise 
5.2 Support Pack 3� on page 30. 

! Recover the primary domain database. See �Recover the Primary Domain 
Database� on page 31.

Applying the GroupWise 5.2 Support Pack 3

Some basic Daylight Saving Time problems that occurred in earlier versions 
of GroupWise, particularly with the 16-bit client, were corrected with the 
GroupWise Support Pack 3 (SP3). If DST values appear to be incorrect when 
you view them in GroupWise Diagnostics, the first thing you do is apply SP3. 
With the new, more robust, formula-based DST definition that originated with 
the 5.2 release and other DST fixes, SP3 is an excellent method to use for 
correcting DST problems in your GroupWise 5.2 system. 

When you apply SP3, you should update all of your GroupWise 5.2 
components, including the GroupWise Administrator DLLs, the GroupWise 
client, and the GroupWise agents. 

The SP3 process requires that you update the Admin DLLs on at least one 
server; however, if other servers on your network store a copy of the 
GroupWise Admin DLLs, each of these will need to have their SYS:\PUBLIC 
directory updated with the SP3 process. All GroupWise administrators on 
your system must be using the same revision (that is, the same 5.2 Support 
Pack) of the Admin DLLs. The SP3 process allows you to update as many 
SYS:\PUBLIC directories as you need to. 

IMPORTANT: If any GroupWise administrator on your network uses an older 
version of the GroupWise 5.2 Admin DLLs to administer GroupWise after SP3 has 
been applied anywhere in your GroupWise system, an incorrect DST date could be 
stored in the domain database. This will cause the incorrect appointments and time 
stamps if those times were established by GroupWise 4.x prior to migration. 

For information about obtaining and applying SP3, and for more details about 
how it works, see Appendix C, �GroupWise 5.2 Support Pack 3,� on page 51.
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Recover the Primary Domain Database

You should perform a database recover on the primary domain database of 
your GroupWise system if: 

! You originally installed GroupWise 5.x with a GWADMN32.DLL file 
dated earlier than April 15, 1998, and then you migrated your GroupWise 
4.x primary domain to GroupWise 5.x with that version of the GroupWise 
snap-in. 

! Some GroupWise 4.x components are still present in the system. 

If you have already applied SP3, you can perform a database recover to ensure 
that the correct DST information is used by the 4.x-level components in your 
system. You can perform a database recover while the database is in use. 

To perform the recovery:

1111 From NetWare Administrator, select the 5.x primary domain object > 
click Tools > GroupWise Utilities > System Maintenance to display the 
GroupWise System Maintenance dialog box. 

2222 Click Recover Database > Run to display the Database Path dialog box. 

3333 If the path to the primary domain database is incorrect, enter the correct 
path, then click OK to begin the recovery process.

or
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If the path to the primary domain database is correct, click OK to begin 
the recovery process. 

When the recovery is complete, the following dialog box is displayed: 

4444 Click OK > Close to close the Recovery Tool dialog box. 

After you have completed the database recovery, check to see if appointment 
times have been corrected. If some appointments are still off by one hour, you 
may need to use the GroupWise Appointment Time Adjuster to correct the 
remaining problems. 

Rechecking the Appointment Times
After you have applied SP3 and recovered the domain database, ask your users 
to recheck the appointment times that have been made between the following 
groups: 

Group A:

The "absolute date" time zone configuration group, which includes: 

! All GroupWise 4.x components 

! All GroupWise 5.0 components 

! All GroupWise 5.1 components 

! The GroupWise 5.2 16-bit client released prior to SP3 

Group B:

The "formula-based" time configuration group, which includes: 

! The GroupWise 5.2 32-bit client 

! The GroupWise 5.2 16-bit client (after SP3 has been applied) 

! The GroupWise 5.5 16-bit client 

! The GroupWise 5.5 32-bit client 
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If the appointment times are correctly synchronized between Group A and 
Group B, prior corrective steps were successful and DST problems are 
resolved. 

If there are still differences in the appointment times between Group A and 
Group B in spite of prior corrective steps, or if you know the differences are 
caused because DST was turned off in GroupWise 4.1 before migration, you 
can do one of two things: 

! Use the GroupWise Appointment Time Adjuster. See �Using the 
GroupWise Appointment Time Adjuster� on page 33

! Check and reschedule appointments. See �Checking and Rescheduling 
Appointments� on page 33 

Using the GroupWise Appointment Time Adjuster 

The GroupWise Appointment Time Adjuster utility, ADJAPPT.EXE, is 
designed to help you resolve appointment times that may be off by one hour 
because of an incorrect DST end date setting or because of a migration from 
GroupWise 4.1. There are two versions of the utility, one designed to run 
against GroupWise 4.1 post offices where the appointments originated before 
the migration, and one designed to run against GroupWise 5.x post offices 
(those in Group A) where the appointments originated before the migration. 

For more information about obtaining and using the GroupWise 4.x 
Appointment Time Adjuster, see Appendix D, �GroupWise 4.x Appointment 
Time Adjuster,� on page 57.

For more information about obtaining and using the GroupWise 5.x 
Appointment Time Adjuster, see Appendix E, �GroupWise 5.x Appointment 
Time Adjuster,� on page 63.

Checking and Rescheduling Appointments

If the number of incorrect appointments is minimal or if you cannot obtain or 
run the GroupWise Time Adjuster utility to help you resolve appointment 
times, you can ask your Group A users to check and reschedule the 
appointments they sent before the migration. 

You should have the users check and reschedule all appointments scheduled 
for recipients residing in any time zone. This procedure will not cause any 
down time for your system. For more information about rescheduling 
appointments, see Appendix F, �Rescheduling Multiple Outbound 
Appointments,� on page 69.
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If you are using GroupWise 5.2:

If the rescheduling is done after SP3 is applied and the primary domain 
database is recovered, the appointments should be correctly synchronized.

If you are using GroupWise 5.5:

The appointments should be correctly synchronized. 

When to Correct DST Problems
If you must change the Daylight Saving Time settings of a domain or a post 
office, the start times for appointments created before the DST reset will shift 
forward or backward by one hour (or the amount of change in DST). This 
happens if appointments are created while GroupWise DST settings are 
incorrect and are later corrected. 

If you use GroupWise 5.2, remember that depending on the GroupWise 5.2 
client being used, different DST records are accessed. A GroupWise client can 
use either an absolute setting for appointment calculation, or it can use a 
formula-based setting for appointment calculation. This inconsistency among 
5.2 clients may cause some clients to experience problems while others do not. 
If you fix a problem at the wrong time, it may appear to introduce more 
problems than it solves. Use the following scenarios as a basic guide to help 
you determine when to correct DST problems. 

Scenario 1
If all users on a GroupWise system are currently using incorrect DST settings, 
you should wait to correct the problem until after DST observance has ended. 
In North America, for example, this would occur during the first week of 
November.

In this situation, all users will continue to be wrong together, so no problems 
should be noticed until after DST ends. At that time, you can adjust the DST 
settings and all new appointments will be created properly. 

Note that GroupWise Remote does not use the domain database for time zone 
information, so appointment times that were created with the Remote client 
will continue to be incorrectly synchronized with real time until after you 
make the DST adjustments to the GroupWise domains and post offices. 
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Scenario 2
If the domains or post offices of some users have correct DST settings and the 
domains and post offices of other users do not use the correct DST settings, 
the situation is more difficult. Some new appointments will be incorrect until 
DST settings are adjusted, but older appointments will appear to shift if you 
make the DST corrections. 

In this situation, the choice of the best strategy depends on how many users 
will be affected. If 10 percent or more of the users are using incorrect DST 
settings, changing the settings as soon as possible may be the best way to 
resolve the problem. After making the change, you may have to use the 
GroupWise Appointment Adjuster to fix the older appointments that have 
shifted. 
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A GroupWise Appointment Time 
Calculation

Because it can be used for communication throughout the world�s time zones, 
a GroupWise® system must keep track of all possible time zone differences 
and how they are defined in its different domains and post offices. This 
document explains how GroupWise calculates and synchronizes these 
appointments. 

Users depend on GroupWise to convert future appointment times across time 
zones so that a synchronized event (such as a telephone conference call) is 
scheduled to begin globally at the same instant. For instance, suppose that 
Daylight Saving Time is in effect. If GroupWise user in Salt Lake City, Utah 
(USA) schedules a telephone conference call for 3:00 p.m. local time (15:00), 
this means the GroupWise client for a user in Phoenix, Arizona (USA) must 
calculate a 2:00 p.m. local time (14:00) appointment, and the GroupWise 
client for a user in Berlin, Germany must calculate an 11:00 p.m. local time 
(23:00) appointment. 

This document contains the following information about the GroupWise 
Appointment Time Calculation Model: 

! �How GroupWise Appointment Times Are Stored� on page 38 

! �How GroupWise Appointment Times Are Converted� on page 38 

In addition, the document provides actual examples of these calculations: 

! �Calculation Examples: DST Off� on page 39

! �Calculation Examples: DST On� on page 40 
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How GroupWise Appointment Times Are Stored
The GroupWise client sending an appointment must calculate and save an 
appointment time in its message store. It implements the following formula:

(APPT - TZO) - DST = SAT

In this formula, 

! APPT - Appointment start time. This variable represents the appointment 
start time at the time zone originating the appointment.

! TZO -Time Zone Offset. This variable represents the amount of offset 
from GMT (+ hours or - hours) at the local time zone. 

! DST - Daylight Saving Time Offset. This variable represents the amount 
of time adjustment made locally for Daylight Saving Time, if it is in 
effect. 

! SAT - Stored Appointment Time. This is time that the sending 
GroupWise client records in the message store as the scheduled 
occurrence of the appointment. 

To apply this formula to the appointment time being stored in the example at 
the beginning of this appendix, we substitute the values for the variables in the 
equation:

 (15:00 - (-7:00)) - 0 = 22:00 

The stored appointment time is 22:00. 

How GroupWise Appointment Times Are Converted
The GroupWise client receiving an appointment must calculate and convert 
appointment times that it retrieves from the message store. It implements the 
following formula to convert the appointment time: 

(SAT + TZO) + DST = RLT 

In this formula, 

! SAT - Stored Appointment Time. This is time that the sending 
GroupWise client records in the message store as the scheduled 
occurrence of the appointment. 

! TZO - Time Zone Offset. This variable represents the amount of offset 
from GMT (+ hours or - hours) at the local time zone. 
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! DST - Daylight Saving Time Offset. This variable represents the amount 
of time adjustment made locally for Daylight Saving Time, if it is in 
effect. 

! RLT - Resulting Local Time. This is the local time when the appointment 
will occur for the user who received the appointment. 

Two examples of the calculation method being applied by the receiving client 
are included in this section. The first example shows how the calculation 
works when DST is off and the second example shows how the calculation 
works when DST is on. 

Calculation Examples: DST Off
To apply the conversion formula to the appointment being received in the 
example at the beginning of this appendix, we assume that the Salt Lake City 
user sends the appointment to another Salt Lake City user. We substitute the 
values for the variables in the equation: 

(22:00 + (-7:00)) + 0 = 15:00 

The appointment is scheduled for 15:00 (3:00 p.m.) in the Salt Lake City time 
zone (MST) when Daylight Saving Time is not in effect. 

If the appointment is sent to a user in Phoenix, the GroupWise client uses this 
calculation: 

(22:00 + (-7:00)) + 0 = 15:00 

The appointment is scheduled for 15:00 (3:00 p.m.) in the Phoenix time zone 
(MST) when Daylight Saving Time is not in effect. 

If the appointment is sent to a user in Berlin, the GroupWise client uses this 
calculation: 

(22:00 + (+1:00)) + 0 = 23:00 

The appointment is scheduled for 23:00 (11:00 p.m.) in the Berlin time zone 
(WET) when Daylight Saving Time is not in effect. 
GroupWise Appointment Time Calculation 39

GroupWise and Daylight Saving Time
104-001300-001

April 6, 2000
Novell Confidential



Manual Rev 99a25 7 March 00
Calculation Examples: DST On
This section elaborates on the example �How GroupWise Appointment Times 
Are Stored� on page 38, using an appointment sent from Salt Lake City, but 
this time we assume that Daylight Saving time is in effect. This means that the 
sending GroupWise client must first calculate the appointment time to store. 

To apply the storage formula to the appointment being sent in the example 
above when DST is in effect, we substitute the values for the variables in the 
equation: 

(APPT - TZO) - DST = SAT 

or 

(15:00 - (-7:00)) - 1 = 21:00 

The stored appointment time is 21:00. 

When the appointment is scheduled locally (Salt Lake City), the GroupWise 
client of the receiving user substitutes the calculated values for the variables 
in the equation: 

(SAT + TZO) + DST = RLT 

or 

(21:00 + (-7:00)) + 1 = 15:00 

The appointment is scheduled for 15:00 (3:00 p.m.) in the Salt Lake City time 
zone (MST) where Daylight Saving Time is in effect. 

If the appointment is sent to a user in Phoenix, the GroupWise client uses this 
calculation: 

(21:00 + (-7:00)) + 0 = 14:00 

The appointment is scheduled for 14:00 (2:00 p.m.) in the Phoenix time zone 
(MST) where Daylight Saving Time is not in effect. 

If the appointment is sent to a user in Berlin, the GroupWise client uses this 
calculation: 

(21:00 + (+1:00)) + 1 = 23:00 

The appointment is scheduled for 23:00 (11:00 p.m.) in the Berlin time zone 
(WET) where Daylight Saving Time is in effect. 
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B The GroupWise Diagnostics Menu and 
Time Zone Settings

Novell® engineers have included a diagnostic menu for GroupWise® in 
NetWare® Administrator that, among other things, can help you obtain 
information about the time zone record of the currently connected domain 
database. 

The GroupWise Diagnostics menu adds diagnostic functionality to NetWare 
Administrator. Although the menu itself is included in the GroupWise 5.x 
installation, it is not readily available until either its string value is added to 
the Windows* Registry, or, as in the case of GroupWise 5.5, a special file is 
present that signals the GroupWise Administration DLLs to display the menu. 
When the menu is displayed, you can use it to check the time zone record for 
its current Daylight Saving Time settings. 

This document contains information that can help you to: 

! �Adding GroupWise Diagnostics Functionality� on page 41 

! �Using GroupWise Diagnostics to Check DST Settings� on page 45 

If you check DST settings and confirm that the settings are incorrect, you must 
take corrective action. For help in choosing which action you should take, see 
�Recognizing DST Issues in Versions of GroupWise� on page 21. 

Adding GroupWise Diagnostics Functionality
The GroupWise Diagnostics menu is included as part of the GroupWise 5.x 
installation, during which GroupWise administrative functions are added to 
NetWare Administrator. By default, however, the menu is not immediately 
available for use. If Daylight Saving Time issues require you to use the tool, 
you must add this diagnostic functionality by changing the Windows Registry. 
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You must then restart NetWare Administrator before the GroupWise 
diagnostics menu is added to the NetWare Administrator Tools menu. 

There are several ways to add GroupWise Diagnostics functionality to 
NetWare Administrator. To add the functionality to NetWare Administrator 
after you have installed GroupWise 5.5, create an empty text file and save it 
as GWSUPP.FIL at the root of the C: drive on the machine where you are 
running NetWare Administrator. GroupWise 5.5 is designed to poll for the 
existence of this file. If it exists, GroupWise Diagnostics functions are added 
to the NetWare Administrator Tools menu. 

If you have other versions of GroupWise 5.x, there are other options for adding 
this functionality: 

! Modify the Windows Registry. This option will work for all GroupWise 
5.x Administration snap-ins. 

! Edit the NWADMNxx.INI File. This option will work for GroupWise 5.0, 
5.1, and 5.2. 

Modifying the Windows Registry 
You can enable GroupWise Diagnostics by directly modifying the Windows 
registry of a network workstation configured to administer a GroupWise 
system. This is done by running the REGEDIT.EXE program and changing 
the string value of the GWSupport DLLs. 

To modify the Windows registry:

1111 From the workstation where you have previously installed GroupWise, 
click Start > Programs > Windows Explorer. 

2222 From the local drive, click the \WINDOWS or \WINNT folder > double-
click the REGEDIT.EXE icon to display the Registry Editor dialog box. 
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3333 Double-click HKEY_CURRENT_USER > double-click Software > 
double-click Novell > double-click GroupWise Admin > double-click 
GroupWise Snapin to display the defined values for the GroupWise snap-
in. 

4444 Click Edit > New > String Value to add an unnamed value to the registry. 

5555 Type GWSupport to replace the "NewValue" name. Note that whatever 
you type as a String Value name is not case-sensitive. 

6666 Double-click GWSupport to display the Edit String dialog box. 

7777 Type 1 in the Value Data field. 
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8888 Click OK > Registry > Exit to close the registry. If NetWare 
Administrator was running on the machine as you edited the registry, you 
need to exit NetWare Administrator and then start it again so that the new 
GWSupport value will be recognized and the diagnostic options will 
become available. 

Editing the NWADMNxx.INI File 
With some versions of NetWare Administrator, you can enable GroupWise 
Diagnostics by indirectly modifying the Windows registry of a network 
workstation configured to administer a GroupWise system. This is done by 
editing the NWADMNxx.INI file, where xx represents the platform of 
NetWare Administrator you are using. Among other things, this .INI file 
registers the .DLL files that snap in to NetWare Administrator, including 
GroupWise functions. 

! If you have already installed GroupWise 5.0 or GroupWise 5.1 at a 
Windows 3.1 workstation, the NWADMN3X.INI file should already exist 
in the \WINDOWS directory, and you can edit this file. 

! If you have already installed GroupWise 5.2 at a Windows 95/98 
workstation, you must create a text file called NWADMN95.INI in the 
\WINDOWS directory. When the file is created, you can add the 
command for diagnostic functionality. 

! If you installed GroupWise 5.2 at a Windows NT* workstation, you must 
create a text file called NWADMNNT.INI in the \WINNT directory. 
When the file is created, you can add the command for diagnostic 
functionality. 

To add the GroupWise Diagnostics functionality, open the .INI file in a text 
editor and add the following lines to the file: 

[GroupWise Snapin]
GWSupport=1 

If you are using the NWADMN3X.EXE version of NetWare Administrator, 
the .INI file will already contain text. If this is the case, the [GroupWise 
Snapin] string will already exist near the top of the file. Simply add the 
GWSupport=1 value on the line following this string. 

After you save the file and run NetWare Administrator (NWADMNxx.EXE) 
again, GroupWise Diagnostics should be available under the Tools menu. 
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Using GroupWise Diagnostics to Check DST Settings
After you have added GroupWise Diagnostics functionality to the Tools menu 
of NetWare Administrator, you can use this tool to check a domain database 
time zone record for its current Daylight Saving Time settings. 

To check the settings:

1111 From the NetWare Administrator browser, click Tools > GroupWise 
Diagnostics > General Edit to display the Record Enumeration dialog 
box. 

2222 Open the drop-down list > click DS_RECORD_TIME_ZONE to display 
the list of defined time zones. 

3333 Choose the time zone whose DST settings you want to check > click the 
Info button to display the Record Information dialog box for the time 
zone you have selected. 
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Verify that the domain database has the correct DST settings by checking 
the fields of the record. 

Domain.PO: This field will be blank. 

Time Zone: This field contains a three-character identification code for 
the time zone. 

Description: This field includes the full name of the time zone, its GMT 
offset, areas of the world where it applies, and its three-character 
identification. 

(Ob.) Offset from GMT: This field contains the value of the GMT offset 
as measured in seconds. This is a GroupWise 4.x setting. 
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Hemisphere: This field contains a numeric value to indicate the 
hemisphere of the world where the time zone applies. Zero (0) indicates 
the northern hemisphere. One (1) indicates the southern hemisphere. 

(Ob.) Daylight Saving Start: This field contains the starting date code 
for Daylight Saving Time as defined in GroupWise 4.x. To read this code, 

1. Convert the code to hexadecimal format. 

2. Parse the hex number into two parts. The first digit represents the 
month value; the last two digits represent the day of the month value. 

3. Convert the hex values to decimal values. 

For example, if the field contains the code 773: 

1. Convert 773 to hexadecimal format, which yields a value of 305. 

2. Parse 305 into 3 and 05. 

3. Convert the 3 hex value to 3 decimal value > convert the 05 hex value 
to 5 decimal value. 

The first decimal value represents the month; month values begin with 
January as zero (0). The second decimal value represents the day of the 
month; day of the month values begin with 1. Using the 3 and 5 decimal 
values, we have the date: April 5. 

If you are having DST problems with appointment times in the 4.x, 5.0, 
5.1, or the 5.2 (16-bit only) clients, double-check this value. 

(Ob.) Daylight Saving End: This field contains the ending date code for 
Daylight Saving Time as defined in GroupWise 4.x. To read this code, 

1. Convert the code to hexadecimal format. 

2. Parse the hex number into two parts. The first digit represents the 
month value; the last two digits represent the day of the month value. 

3. Convert the hex values to decimal values. 

For example, if the field contains the code 2329: 

1. Convert 2329 to hexadecimal format, which yields a value of 919. 

2. Parse 919 into 9 and 19. 

3. Convert the 9 hex value to 9 decimal value > convert the 19 hex value 
to 25 decimal value. 

The first decimal value represents the month; month values begin with 
January as zero (0). The second decimal value represents the day of the 
The GroupWise Diagnostics Menu and Time Zone Settings 47

GroupWise and Daylight Saving Time
104-001300-001

April 6, 2000
Novell Confidential



Manual Rev 99a25 7 March 00
month; day of the month values begin with 1. Using the 9 and 25 decimal 
values, we have the date: October 25. 

If you are having DST problems with appointment times in the 4.x, 5.0, 
5.1, or the 5.2 (16-bit only) clients, double-check this value. 

(Ob.) Daylight Saving Offset: This field contains the value of the DST 
offset as measured in seconds. This is a GroupWise 4.x setting. 

If you are having DST problems with appointment times in the 4.x, 5.0, 
5.1, or the 5.2 (16-bit only) clients, double-check this value. 

Offset from GMT (Min): This field contains the value of the GMT offset 
as measured in minutes. This is a GroupWise 5.x setting. 

Daylight Savings Bias (Min): Not applicable for administrators. Used 
for code testing. 

Daylight Start - Month: This field contains the month of the year when 
Daylight Saving Time starts. This is a GroupWise 5.x setting. 

Daylight Start - Occurrence: This field correlates with the Daylight 
Start - Weekday field (DSW), which is explained below. The value in this 
field specifies which occurrence of DSW will begin Daylight Saving 
Time. A value of 1 designates the first occurrence of DSW in the month 
as the DST start day, a value of 2 designates the second occurrence of that 
day in the month, and so on. The values range from 1 to 5. This is a 
GroupWise 5.x setting. 

Daylight Start - Hour: This field contains the hour of the day when 
Daylight Saving Time starts. The first hour is numbered 1, the second 
hour by 2, and so forth. This is a GroupWise 5.x setting. 

Daylight Start - Minute: This field contains the minute of the hour when 
Daylight Saving Time starts. This is a GroupWise 5.x setting. 

Daylight Start - Weekday: This field indicates the day of the week when 
Daylight Saving Time starts. Sunday is represented by 0, Monday is 1, 
Tuesday is 2, Wednesday is 3, Thursday is 4, Friday is 5, and Saturday is 
6. This is a GroupWise 5.x setting. 

Standard Time Bias (Min): This field contains the value of Standard 
Time bias, as measured in minutes. 

Standard Start - Month: This field contains the month of the year when 
Standard Time starts. This is a GroupWise 5.x setting. 

Standard Start - Occurrence: This field correlates with the Standard 
Start - Weekday field (SSW), which is explained below. The value in this 
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field specifies which occurrence of SSW will begin Standard Time. A 
value of 1 designates the first occurrence of SSW in the month as the 
Standard Time start day, a value of 2 designates the second occurrence of 
that day in the month, and so on. The values range from 1 to 5. This is a 
GroupWise 5.x setting. 

Standard Start - Hour: This field contains the hour of the day when 
Standard Time starts. The first hour (1:00 a.m.) is numbered 1, the second 
hour by 2, and so forth. This is a GroupWise 5.x setting. 

Standard Start - Minute: This field contains the minute of the hour 
when Standard Time starts. This is a GroupWise 5.x setting. 

Standard Start - Weekday: This field indicates the day of the week 
when Standard Time starts. Sunday is represented by 0, Monday is 1, 
Tuesday is 2, Wednesday is 3, Thursday is 4, Friday is 5, and Saturday is 
6. This is a GroupWise 5.x setting. 

Last Modification Operation: This field contains a code that indicates 
the type of modification operation performed on the database. 

Migration Flag: This field contains a code indicating whether this 
domain database has been migrated from GroupWise 4.1 

Rec Version: This field contains a code indicating the version of this 
domain database record. 

Last Modification: This field contains the month, day, and year of the 
last modification to this domain database. 
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C GroupWise 5.2 Support Pack 3

When you install GroupWise® on a NetWare® 4.1x server, you not only 
extend the schema of the NDS® tree where GroupWise objects will be 
logically located, you also add GroupWise functionality to NetWare 
Administrator so that you can administer GroupWise as a "snap-in" to that 
program. This functionality, visible as added menu options and dialog boxes, 
is possible because the installation adds several GroupWise-specific Dynamic 
Link Libraries (DLLs) to the SYS:\PUBLIC directory on the Windows* 
workstation where you run NetWare Administrator. 

When you run NetWare Administrator on this workstation, it knows that it 
must "snap in" or load the GroupWise Administration DLLs by checking a 
Windows registry setting. On a Windows 95/98 or Windows NT* machine 
running a GroupWise 5.2 installation, this registry setting is located at 

HKEY_CURRENT_USER\Software\NetWare\Parameters\NetWare 
Administrator\Snapin View DLLs WIN95 

Here, the registry points to a file that represents the core GroupWise 
Administration DLL, GWADMA32.DLL. NetWare Administrator looks for 
this file in the same directory from which it (that is, NetWare Administrator 
itself) is launched. Note that you can configure any Windows workstation to 
run NetWare Administrator and GroupWise 5.2 by running SETUPGW.EXE. 
This utility registers the correct DLLs for the workstation. SETUPGW.EXE is 
available in the software distribution directory \ADMIN directory. 

If you determine that your GroupWise 5.2 system is having problems 
correlating appointments because of Daylight Saving Time (DST) 
inaccuracies, you should update all of your GroupWise 5.2 components, 
including the GroupWise snap-in, GroupWise clients, and GroupWise agents. 
The most current update for GroupWise 5.2 is called the GroupWise Support 
Pack 3 (SP3). This "patch" corrects a number of 5.2 issues, and its update code 
also helps correct a deficiency in DST calculation. 
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If SP3 is to be effective, all of the administrators in your GroupWise system 
must use the same revision of the GroupWise snap-in. The SP3 process 
requires you to update the snap-in on at least one server; however, you must 
also update the SYS:\PUBLIC directory all other servers that store a copy of 
the GroupWise snap-in. The patch process for SP3 and later will allow an 
administrator to update as many SYS:\PUBLIC directories as needed. 

If you apply SP3 to GroupWise 5.2 components on one server, and then you 
subsequently use a non-patched version of the 5.2 snap-in to administer 
GroupWise, an incorrect DST date could be stored in the domain database. 
This could cause GroupWise 4.x appointments and time stamps to be 
incorrect. To correct the problem, unload all of the agents and gateways, apply 
SP3 on the unpatched server, then restart all of the agents and gateways. 

You can determine whether SP3 has been previously applied to your 
GroupWise system by checking the creation date of a file located in the 
\ADMIN\PUBLIC subdirectory of the software distribution directory. The 
file, GWADMA32.DLL, will have a creation date of 4/15/98 or later if SP3 
has been applied to this directory. Note that not all files in the directory may 
have the same date. 

The remainder of this section contains information that will help you apply the 
GroupWise 5.2 Support Pack 3 in the situation that is best for you: 

! �Obtaining and Applying the GroupWise 5.2 Support Pack 3� on page 52 
lists the steps for the complete application of SP3. 

! �Performing Manual SP3 Updates to Admin DLLs Only� on page 55 lists 
only the steps for applying SP3 to the GroupWise administration DLLs 
but not the steps for applying it to GroupWise clients or agents. 

Obtaining and Applying the GroupWise 5.2 Support 
Pack 3

Depending on the current state of the software distribution directory on a file 
server, several different files may be required for a complete application of 
SP3. Because this variability of file combinations, Novell has created a 
Download Assistant tool to examine the files in a specified software 
distribution directory and then download the correct SP3 files. 

The SP3 Download Assistant, GW52SP3A.EXE, is available for download 
from the World Wide Web as a self-extracting, compressed file. Once 
downloaded and executed, the Download Assistant determines which 
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GroupWise 5.2 CD was used to initially install GroupWise. Once this is 
discovered, the assistant launches your web browser and finds the file 
download location of the SP3 code specifically designed to update the your 
version of GroupWise 5.2. 

To obtain and apply the GroupWise 5.2 Support Pack 3: 

1111 Obtain the SP3 Download Assistant from the  Novell Support Connection 
Worldwise Sites® (http://www.support.novell.com/misc/
worldwide.htm). Use the File Finder to search for GW52SP3. 

2222 Copy this file to a temporary directory and run it to extract the enclosed 
files. 

3333 When the extraction is complete, double-click the SETUP.EXE file to run 
the SP3 Download Assistant. The process launches your Internet browser 
to the download site of the SP3 image set that you need. 

4444 At the SP3 download site, follow the directions to download the 
appropriate SP3 image set. 

5555 From the directory where you downloaded the SP3 image set, double-
click the program executable to apply SP3 to a single software 
distribution directory. 

The program launches the SP3 wizard, which displays a dialog box with 
the following buttons: 

Update Admin Files. When you run the SP3 wizard on a Windows 95/
98 workstation and click Update Admin Files, the wizard prompts you for 
the path to the NetWare SYS:\PUBLIC directory of that server, then 
copies the patched Admin DLLs from the software distribution directory 
to the PUBLIC\WIN95 directory and the 
PUBLIC\WIN95\NLS\LANGUAGE directory. If you run the wizard on 
a Windows NT machine, it copies patched DLLs to the PUBLIC\WINNT 
directory and the PUBLIC\WINNT\NLS\LANGUAGE directory. 

If you launch NetWare Administrator from directories other than the one 
you specify, make sure that each of these directories is removed or 
patched with SP3 code. Failure to do so can cause problems with Daylight 
Saving Time settings. You can choose this option as many times as 
necessary to patch GroupWise Administrator DLLs. 

If, during the SP3 update, you fail to apply the Update Admin Files option 
to every SYS:/PUBLIC directory of every file server where you run the 
NetWare Administrator, you must distribute the patched DLLs manually. 
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For information about how to do this, see �Performing Manual SP3 
Updates to Admin DLLs Only� on page 55.

Update Agent Files. If you choose this option, the SP3 wizard launches 
the INSTALL.EXE program from the software\AGENTS directory that 
was patched. Although you can run this program later, the SP3 wizard 
automates the process for you. 

Update Internet Agent Files. If you choose this option, the SP3 wizard 
launches the SETUP.EXE program from the 
software\INTERNET\GWIA directory that was patched. Although you 
can run this program later, the SP3 wizard automates the process for you. 

Update WebAccess Agent Files. If you choose this option, the SP3 
wizard launches the SETUP.EXE program from the 
software\INTERNET\WEBACCES directory that was patched. 
Although you can run this program later, the SP3 wizard automates the 
process for you. 

Force Auto-Update for Windows Clients. If you choose this option, the 
SP3 wizard launches instructions on how to use the GroupWise Auto-
Update feature to push the GroupWise client out to user�s desktops, thus  
forcing users to update their Windows clients. You can perform an auto-
update manually at any time. For more information, see the System 
Update guide. 

Note that if your GroupWise system has more than one software 
distribution directory, you can copy the contents of this directory to other 
directories. See Step 8 for more information. 

6666 Run the Installation Advisor from the patched software distribution 
directory to install updated GroupWise software.

You need to reinstall new software for all GroupWise components. For 
more information about updating an installation, see the System Update 
guide.

7777 Restart the patched GroupWise agents. The GroupWise agents are not 
patched until they have been unloaded and reloaded. Copying the agents 
to the \SYSTEM directory does not automatically replace what is already 
in memory. Make sure you install the agents to every server that is 
running GroupWise agents.

Note that you can determine whether an agent on a NetWare server is 
running the 5.2 SP3 code by going to a NetWare file server system 
console prompt and typing modules. The version display should specify 
version 5.20 and should be dated 4/15/98 or later.
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8888 Copy SP3 to all other software distribution directories. 

The SP3 wizard applies the patch to only one software distribution 
directory at a time. If there is more than one such directory in your 
GroupWise system, you should copy the patched directory to overwrite 
the other directories; otherwise, you must apply SP3 to each directory 
independently. 

There are two ways to accomplish an update to the software distribution 
directory. 

! Use the Software Directory Management tool. Although effective, 
this method also prompts users to update the client software, which 
you may not choose to do. For more information about this tool, see 
"Updating a Software Distribution Directory" in "Updating Your 
GroupWise System" in the System Update guide. 

! Rename the old directory, then copy it and its subdirectories to the 
path where the old directory was located. To save time, you can use 
the XCopy utility to perform the copy (xcopy /s /e). 

This copying method will not work if any user is using GroupWise 
or any GroupWise utility. 

Performing Manual SP3 Updates to Admin DLLs Only
If, during the SP3 update, you failed to apply the Update Admin Files option 
to every SYS:\PUBLIC directory of every file server where you run the 
NetWare Administrator, you will have to distribute the patched DLLs 
manually. This is also a good update method for administrators who want to 
save time by applying SP3 to the Admin snap-in DLLS only, not to the client 
or to the agents. 

To manually update the Admin DLLs:

1111 Select a GroupWise software distribution directory where SP3 has been 
applied.

You can confirm this by going to the \ADMIN\PUBLIC subdirectory and 
checking the date of the GWADMA32.DLL file. If the file is dated 4/15/
98 or later, SP3 has been applied.

2222 Confirm that a file server needs SP3 by checking the creation date of 
GWADMA32.DLL, located in the SYS:PUBLIC\WINxx directory. If the 
file is dated prior to 4/15/98, proceed to step 3. 
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3333 Copy all of the files from the software\ADMIN\PUBLIC directory 
located at the patched file server to the SYS:\PUBLIC\WINxx directory 
of the non-patched file server. 

4444 Copy all of the files from the software \ADMIN\PUBLIC\NLS\language 
directory located at the patched server to the 
SYS:PUBLIC\WINxx\NLS\language directory of the non-patched file 
server. 

5555 Repeat steps 2 through 4 for each file server that will run the GroupWise 
snap-in DLLs. 
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D GroupWise 4.x Appointment Time 
Adjuster

The GroupWise® 4.x Appointment Time Adjuster (ATA) version 1.5 
(ADJAPPT.EXE) modifies appointment times that may be incorrect by one 
hour due to an incorrect DST end date setting, or due to a problem created by 
migrating the GroupWise 4.1 primary domain to GroupWise 5.2.0.

Understanding This Utility
The time adjuster program, which can be run on only one 4.x post office at a 
time, is designed to allow the GroupWise system administrator to: 

! Determine and set a time offset that can be applied to move appointment 
times forward or backward. 

! Select appointments to be modified by specifying an exact date or a range 
of dates when the appointments were created. 

! Exclude modification of some appointments based on the post office or 
group of post offices from which they were sent. 

The amount of time needed to run the appointment time adjuster on one 4.x 
post office will vary according to: 

! The number of appointments falling within the specified date ranges. 

! The total number of records in the message store databases. 

! The network connection (LAN or WAN) between the workstation 
running the ATA and the file server where the post office resides. 
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If you want to use the appointment time adjuster, you will need to perform the 
following tasks: 

! �Obtaining and Installing the 4.x Appointment Time Adjuster� on page 
58

! �Preparing to Run the 4.x Appointment Time Adjuster� on page 58

! �Running the 4.x Appointment Time Adjuster� on page 59

You may also be interested in the section entitled �Tips for Using the 4.x 
Appointment Time Adjuster� on page 61.

Obtaining and Installing the 4.x Appointment Time 
Adjuster 

The GroupWise 4.x Appointment Time Adjuster is available as a self-
extracting, compressed file, GWATA415.EXE. The file is available for 
download from the Novell Support Connection® Worldwide Sites (http://
www.support.novell.com/misc/worldwide.htm)  Use the File Finder to search 
for GWATA415. 

Copy this file to a temporary directory and run it to extract the enclosed files. 

Preparing to Run the 4.x Appointment Time Adjuster
Before you use the GroupWise 4.x Appointment Time Adjuster, you should 
run the most current version of the GroupWise 4.1 OFCHECK.EXE program 
against all user and message databases in the post office. Running the 
Analyze/Fix Structure option in OFCHECK.EXE will help to prevent a 
General Protection Fault when you use the appointment adjuster. After you 
run OFCHECK.EXE, you should also make a complete backup of your entire 
GroupWise system. For more information about OFCHECK.EXE, see the  
GroupWise 4.1 Administration Guide (http://www.novell.com/groupwise/
administration/gw41/gwadmn.html).

Because the appointment time adjuster works on only one post office at a time, 
you should close the post office, make sure the message queues are empty, and 
then stop the 4.x OFS process for the post office you will be adjusting. You 
will find the message queues for the post office in the post_office\WPCSOUT\ 
and post_office\WPCSIN\ directories and their subdirectories. For more 
information about the GroupWise 4.1 directory structure, see the GroupWise 
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4.1 Administration Guide (http://www.novell.com/groupwise/administration/
gw41/gwadmn.html). 

After you close the post office, you should make a copy of the entire post 
office directory before you start the ATA. This will make it easier for you to 
restore the post office if appointments are not correctly adjusted. If the post 
office is closed, you can copy the backup to the post office location on the 
server. 

As part of the task of adjusting appointments, you may also want to identify a 
GroupWise user that is experiencing the appointment problem you want to 
correct. After you close the post office, make a backup, and run the ATA, you 
can examine this user�s appointments (after obtaining permission) to verify 
whether the problem has been corrected. If your examination reveals that the 
appointments are still incorrect, you can restore the post office from your 
backup. When you are confident the appointment times have been corrected 
properly, you can open the post office again. 

Running the 4.x Appointment Time Adjuster
When you have installed the appointment time adjuster (ATA), you can start 
the program using the following syntax: 

AdjAppt path_to_post_office [+ or -]offset_in_hours 
[switches] 

Remember that the ATA only works on one 4.x post office at a time. You must 
indicate the mapped path to this post office. You must also indicate in the 
command line the amount of time offset (in hours) with which the 
appointments should be modified. The ATA will modify all appointment times 
forward or backward according to the amount of offset you indicate. The 
offset must be preceded with a plus (+) or minus (-) to be valid. The following 
formats can be used: 

! +1 adjust appointments forward 1 hour 

! +0.5 adjust appointments forward 1/2 hour 

! +1.5 adjust appointments forward 1-1/2 hours 

! +1,5 adjust appointments forward 1-1/2 hours 

! +1:30 adjust appointments forward 1-1/2 hours 

! +30m adjust appointments forward 1/2 hour 

! +1h30m adjust appointments forward 1-1/2 hours 
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By using startup switches, you can also specify the dates of the appointments 
that you want to modify, or specify the user ID of a sender whose 
appointments you suspect of a DST error. Startup switches will also let you 
exclude adjustment to the appointments that have been sent from a particular 
post office or group of post offices to users in the post office you are adjusting. 
Note that the nocreateupdate switch is mandatory. 

See Appendix G, �Startup Switches,� on page 73 for a list of startup switches 
and explanations of how they are used. 

Startup Examples
To assist you with understanding how these startup options can be used with 
the 4.x adjuster, study the following scenarios. 

Scenario 1

The administrator has a GroupWise system spread across several time zones. 
She wants to make make adjustments to appointments based on the following 
criteria: 

! Affected appointments must have been created by users in a post office 
having an incorrect DST end date. 

! Appointments created by users in post offices with the correct DST End 
date must be excluded from modification. The Berlin post office has the 
correct end date. 

! Affected appointments must have been created prior to correcting the 
DST end date on September 24, 1997. 

! Affected appointments must have been scheduled for dates between 
October 1 and October 25, 1997. 

! Affected appointments need to be move backward one hour. 

The syntax to accomplish this modification would be: 

ADJAPPT.EXE drive:\path_to_po_dir -1 /ce-98/09/24 /as-98/10/
01 /ae-98/10/25 /nocreateupdate /ex-berlin 

To carry out this command, the 4.x Appointment Time Adjuster ignores any 
appointments created by users in the Berlin post office, but checks the 
appointments in all other post offices. If there are appointments created on 
September 24, 1998 or earlier, and if those appointments are scheduled to 
occur any day between and including October 1, 1998 and October 25, 1998, 
the starting times of those appointments will be shifted to one hour earlier. 
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Scenario 2

The administrator has a GroupWise system spread across several time zones. 
She wants to make make adjustments to appointments based on the following 
criteria: 

! Affected appointments must have been created by users in a post office 
having an incorrect DST end date. Several post offices have the correct 
end date. She listes them in a host exclusion file. 

! Appointments created by users in post offices with the correct DST end 
date must be excluded from modification. 

! Affected appointments must have been created prior to correcting the 
DST end date on September 24, 1998. 

! Affected appointments must have been scheduled for dates between 
October 1 and October 25, 1998. 

! Affected appointments need to be move backward one hour. 

The syntax to accomplish this modification would be: 

ADJAPPT.EXE drive:\path_to_po_dir -1 /ce-98/09/24 /as-98/10/
01 /ae-98/10/25 /nocreateupdate /ex-@drive:\path\hosts.txt 

To carry out this command, the 4.x Appointment Time Adjuster ignores any 
appointments created by users listed in the host exclusion file, but checks the 
appointments in all other remaining post offices in the system. If there are 
appointments created on September 24, 1998 or earlier, and if those 
appointments are scheduled to occur any day between and including October 
1, 1998 and October 25, 1998, the  starting times of those appointment will be 
shifted to one hour earlier. 

Tips for Using the 4.x Appointment Time Adjuster
The GroupWise 4.x Appointment Time Adjuster does not check to determine 
if its process has previously been run on a post office: every time you run the 
program, the appointments in the post office are modified according to the 
specified command line settings. This means that if the command line settings 
are not changed, the time offset continues to shift. 

You can use this no-check design to your advantage. If you need to reverse a 
change you made, you can change the offset from + to - or from - to +. This 
procedure works only if you also use the /nocreateupdate startup switch. 
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E GroupWise 5.x Appointment Time 
Adjuster

The GroupWise® 5.x Appointment Time Adjuster version 1.5 
(ADJAPPT.EXE) modifies appointment times that may be incorrect by one 
hour due to an incorrect DST end date setting, or due to a problem created by 
migrating the GroupWise 4.1 primary domain to GroupWise 5.2.0.

Understanding This Utility
The time adjuster program, which can be run on only one 5.0, 5.1, or 5.2 post 
office at a time, is designed to allow the GroupWise system administrator to: 

! Determine and set a time offset that can be applied to move appointment 
times forward or backward. 

! Select appointments to be modified by specifying an exact date or a range 
of dates when the appointments were created. 

! Exclude modification of some appointments based on the post office or 
group of post offices from which they were sent. 

The amount of time needed to run the appointment time adjuster (ATA) on one 
post office will vary according to: 

! The number of appointments falling within the specified date ranges. 

! The total number of records in the message store databases. 

! The network connection (LAN or WAN) between the workstation 
running the ATA and the file server where the 5.x post office resides. 
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If you want to use this tool, you will need to perform the following tasks: 

! �Obtaining and Installing the 5.x Appointment Time Adjuster� on page 
64 

! �Preparing to Run the 5.x Appointment Time Adjuster� on page 64 

! �Running the 5.x Appointment Time Adjuster� on page 65 

You may also be interested in the section entitled �Tips for Using the 5.x 
Appointment Time Adjuster� on page 67.

Obtaining and Installing the 5.x Appointment Time 
Adjuster 

The GroupWise 5.x Appointment Time Adjuster is available as a self-
extracting, compressed file, GWATA515.EXE. The file is available for 
download from the Novell Support Connection® Worldwide Sites (http://
www.support.novell.com/misc/worldwide.htm). Use the File Finder to search 
for GWATA515. 

Copy this file to a temporary directory and run it to extract the enclosed files. 

Preparing to Run the 5.x Appointment Time Adjuster 
Before you use the GroupWise 5.x Appointment Time Adjuster, you should 
run the most current version of the GroupWise 5.x GWCHECK.EXE program 
against all user and message databases in the post office. Running the 
Analyze/Fix Structure option in GWCHECK.EXE will help to prevent a 
General Protection Fault when you use the appointment adjuster. After you 
run GWCHECK.EXE, you should also make a complete backup of your entire 
GroupWise system. For more information about the GWCHECK.EXE utility, 
see "Stand-Alone Maintenance Programs" in the Maintenance guide. Note 
that this information is also pertinent for GroupWise 5.2. 

Because the ATA works on only one post office at a time, you should close the 
post office, make sure the message queues are empty, and then stop the 5.x 
POA process for the post office you will be adjusting. You will find the 
message queues for the post office in the post_office\WPCSOUT\ and 
post_office\WPCSIN\ directories and their subdirectories. For more 
information about the GroupWise 5.x directory structure, see "Directory 
Structure Diagrams" in the Troubleshooting 3: Message Flow and Directory 
Structure guide. 
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After you close the post office, you should make a copy of the entire post 
office directory before you start the ATA. This will make it easier for you to 
restore the post office if appointments are not correctly adjusted. If the post 
office is closed, you can copy the backup to the post office location on the 
server. 

As part of the task of adjusting appointments, you may also want to identify a 
GroupWise user that is experiencing the appointment problem you want to 
correct. After you close the post office, make a backup, and run the ATA, you 
can examine this user�s appointments (after obtaining permission) to verify 
whether the problem has been corrected. If your examination reveals that the 
appointments are still incorrect, you can restore the post office from your 
backup. When you are confident the appointment times have been corrected 
properly, you can open the post office again. 

Running the 5.x Appointment Time Adjuster
When you have installed the appointment time adjuster (ATA), you can start 
the program using the following syntax: 

AdjAppt path_to_post_office [+ or -]offset_in_hours 
[switches] 

Remember that the ATA only works on one 5.x post office at a time. You must 
indicate the mapped path to this post office. You must also indicate in the 
command line the amount of time offset (in hours) with which the 
appointments should be modified. The ATA will modify all appointment times 
forward or backward according to the amount of offset you indicate. The 
offset must be preceded with a plus (+) or minus (-) to be valid. The following 
formats can be used: 

! +1 adjust appointments forward 1 hour 

! +0.5 adjust appointments forward 1/2 hour 

! +1.5 adjust appointments forward 1-1/2 hours 

! +1,5 adjust appointments forward 1-1/2 hours 

! +1:30 adjust appointments forward 1-1/2 hours 

! +30m adjust appointments forward 1/2 hour 

! +1h30m adjust appointments forward 1-1/2 hours 

By using startup switches, you can also specify the dates of the appointments 
that you want to modify, or specify the user ID of a sender whose 
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appointments you suspect of a DST error. Startup switches will also let you 
exclude adjustment to the appointments that have been sent from a particular 
post office or group of post offices to users in the post office you are adjusting. 
Note that the nocreateupdate switch is mandatory. 

See Appendix G, �Startup Switches,� on page 73 for a listing of startup 
switches and explanations of how they are used. 

Startup Examples
To assist you with understanding how these startup options can be used with 
the 5.x adjuster, study the following scenarios. 

Scenario 1

The administrator has a GroupWise system spread across several time zones. 
She wants to make adjustments to appointments based on the following 
criteria: 

! Affected appointments must have been created by users in a post office 
having an incorrect DST end date. 

! Appointments created by users in post offices with the correct DST End 
date must be excluded from modification. The Berlin post office has the 
correct end date. 

! Affected appointments must have been created prior to correcting the 
DST end date on September 24, 1997. 

! Affected appointments must have been scheduled for dates between 
October 1 and October 25, 1997. 

! Affected appointments need to be move backward one hour. 

The syntax to accomplish this modification would be: 

ADJAPPT.EXE drive:\path_to_po_dir -1 /ce-98/09/24 /as-98/10/
01 /ae-98/10/25 /nocreateupdate /ex-berlin 

To carry out this command, the 5.x Appointment Time Adjuster ignores any 
appointments created by users in the Berlin post office, but checks the 
appointments in all other post offices. If there are appointments created on 
September 24, 1998 or earlier, and if those appointments are scheduled to 
occur any day between and including October 1, 1998 and October 25, 1998, 
the starting times of those appointments will be shifted to one hour earlier. 
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Scenario 2

The administrator has a GroupWise system spread across several time zones. 
She wants to make adjustments to appointments based on the following 
criteria: 

! Affected appointments must have been created by users in a post office 
having an incorrect DST end date. Several post offices have the correct 
end date. She lists them in a host exclusion file. 

! Appointments created by users in post offices with the correct DST end 
date must be excluded from modification. 

! Affected appointments must have been created prior to correcting the 
DST end date on September 24, 1998.

! Affected appointments must have been scheduled for dates between 
October 1 and October 25, 1998.

! Affected appointments need to be move backward one hour. 

The syntax to accomplish this modification would be: 

ADJAPPT.EXE drive:\path_to_po_dir -1 /ce-98/09/24 /as-98/10/
01 /ae-98/10/25 /nocreateupdate /ex-@drive:\path\hosts.txt 

To carry out this command, the 5.x Appointment Time Adjuster ignores any 
appointments created by users listed in the host exclusion file, but checks the 
appointments in all other remaining post offices in the system. If there are 
appointments created on September 24, 1998 or earlier, and if those 
appointments are scheduled to occur any day between and including October 
1, 1998 and October 25, 1998, the starting times of those appointment will be 
shifted to one hour earlier. 

Tips for Using the 5.x Appointment Time Adjuster

5.x Post Offices Not Checked for Previous Adjuster Use
The GroupWise 5.x Appointment Time Adjuster does not check to determine 
if its process has previously been run on a post office: every time you run the 
program, the appointments in the post office are modified according to the 
specified command line settings. This means that if the command line settings 
are not changed, the time offset continues to shift. 
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You can use this no-check design to your advantage. If you need to reverse a 
change you made, you can change the offset from + to - or from - to +. This 
procedure only works if you also use the /nocreateupdate startup switch. 

Checking the Client Versions Running Against the Post Office
If the GroupWise 5.2 Service Pack 3 (SP3) has not been applied to the 
GroupWise 5.2 16-bit client, it will continue to use an absolute time value for 
calculating Daylight Saving Time. The same is true of GroupWise 5.2 32-bit 
clients that are not patched with SP3. If the post office that you are adjusting 
services a combination of GroupWise 5.2 32-bit clients and the GroupWise 
5.2 16-bit clients, you must be aware of the version of these clients. You need 
to adjust only the appointments sent by clients that have not had the SP3 patch 
applied. 

You must run the ATA at the post office of every non-SP3 user and you must 
run it a second time against every post office to which that user sent an 
appointment. If this will require an excessive number of sessions with the 
appointment time adjuster, it may be to your advantage to require users to 
reschedule appointments rather than to use the appointment adjuster. For more 
information about rescheduling appointments, see Appendix F, �Rescheduling 
Multiple Outbound Appointments,� on page 69.
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F Rescheduling Multiple Outbound 
Appointments

If the number of outgoing appointments affected by DST changes is minimal, 
or if you cannot obtain or run the GroupWise® Appointment Time Adjuster 
utility to help you resolve appointment times, you may ask your GroupWise 
users to check and reschedule the appointments they have sent for recipients 
residing in any time zone. This procedure will not cause any down time for 
your system. 

If users must reschedule a number of appointments, it would be impractical for 
them to look through their calendars for appointments they have sent. Instead, 
they can set up filters in their 4.x or 5.x versions of the GroupWise to retrieve 
their outbound appointments. Once these appointments are retrieved, they can 
then be rescheduled as needed. 

This document contains information about the filtering and rescheduling 
process necessary for the following GroupWise clients: 

! �GroupWise 4.1 Client for Windows� on page 70 

! �GroupWise 4.1 Client for DOS� on page 70 

! �GroupWise 4.1 Client for Macintosh� on page 71 

! �GroupWise 5.x 32-bit Client� on page 71 
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GroupWise 4.1 Client for Windows
The GroupWise 4.1 Client for Windows* lets a user retrieve a list of all of the 
appointments sent from his or her mailbox. To retrieve the list: 

1111 Double-click the Out Box in the Main Window > click Out Box to select 
it for filtering. 

2222 Click View > Filter to open the Filter dialog box. 

3333 Select Appointment to display a list box of all outgoing appointments. 

To reschedule and resend each appointment:

1111 Click the appointment from the appointment list box. 

2222 Click Send > Resend > check the appointment time and change it if 
necessary. 

3333 Click Send. You will be prompted to retract the original appointment. 

4444 Click Yes to retract the original appointment. 

5555 Repeat steps 1-4 for every appointment you want to reschedule.

Note that the GroupWise 4.1 Client for Windows is designed to run on a 
16-bit operating system. The user interface for this 16-bit client is very 
similar to the interface for the GroupWise 5.x 16-bit client. If your users 
have the 5.x 16-bit client, they can use the instructions for appointment 
rescheduling that are provided here for the 4.1 Windows client.

GroupWise 4.1 Client for DOS
The GroupWise 4.1 Client for DOS lets a user retrieve a list of all of the 
appointments sent from his or her mailbox. To retrieve the list:

1111 Choose the Window menu, then choose Out Box to select it for filtering. 

2222 Choose Views, then choose Filters to open the Filter dialog box. 

3333 Select Appointment to display a list box of all outgoing appointments. 

To reschedule and resend each appointment:

1111 Choose the appointment from the appointment list box. 

2222 Choose the Send menu, then choose Edit/Resend to display the Resend 
dialog box. 
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3333 Choose Delete and Resend to retract the original item and reschedule a 
new item. 

4444 Choose OK.

5555 Make the necessary changes to the appointment, then choose Send. 

6666 Repeat steps 1-5 for every appointment you want to reschedule. 

GroupWise 4.1 Client for Macintosh
The GroupWise 4.1 Client for Macintosh* lets a user retrieve a list of all of the 
appointments sent from his or her mailbox. To retrieve the list:

1111 Double-click the Out Box in the Main Window. 

2222 Click Tools > Filter to open the Filter dialog box. 

3333 Select Appointment to display a list box of all outgoing appointments. 

To reschedule and resend each appointment: 

1111 Click the appointment from the appointment list box. 

2222 Click Actions > Read > check the appointment time and change it if 
necessary. 

3333 Click Send. You will be prompted to retract the original appointment. 

4444 Click Retract to retract the original appointment. 

5555 Repeat steps 1-4 for every appointment you want to reschedule. 

Note that the user interface of the GroupWise 4.1 Client for Macintosh is very 
similar to the interface for the GroupWise 5.x Client for Macintosh. If your 
users have the 5.x Macintosh client, they can use the instructions for 
appointment rescheduling that are provided here for the 4.1 Macintosh client. 

GroupWise 5.x 32-bit Client 
The GroupWise 32-bit client for GroupWise 5.0, 5.1, and 5.2 stores all 
appointments in the user�s mailbox. To retrieve the list:

1111 On the toolbar, click  if your mailbox is not displaying outbound items 
(including appointments). 

2222 Click the appointment you want to reschedule. 

3333 Click Actions > Resend. 
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4444 Make changes to the appointment > click Send. 

5555 Click Yes to retract the original appointment. 

Note that it will probably not be necessary to reschedule appointments in the 
GroupWise 5.5 client because of DST problems. 
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G Startup Switches

This section discusses the startup switches available for GroupWise® 4.x and 
for GroupWise 5.x.

/cs-date
Modify appointments if created after date. If you do not use the /cs switch, the 
ATA checks all appointments created before a date specified by the /ce switch. 

The ATA interprets dates on the command line in the [yy]yy/mm/dd format 
unless the /us switch is also included in the command.

Syntax:
adjappt J:\develop -1
/cs-98/08/03
/nocreateupdate

/ce-date
Modify appointments if created before date. If you do not use the /ce switch, 
the ATA checks all appointments created after the date specified by the /cs 
switch. 

The ATA interprets dates on the command line in the [yy]yy/mm/dd format 
unless the /us switch is also included in the command.

/cs-date /as-date /nocreateupdate

/ce-date /ui-UserID /ex-postofficename

/ae-date /us /ex-@path
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Syntax:
adjappt J:\develop -1 
/ce-98/08/05 
/nocreateupdate 

/as-date
The ATA interprets dates on the command line in the [yy]yy/mm/dd format 
unless the /us switch is also included in the command. 

Modify appointments if date range starts date. If you do not use the /as switch, 
the ATA checks all appointments created before the date specified by the /ae 
switch. 

Syntax:
adjappt J:\develop -1 
/as-98/08/03 /ae-98/08/17 
/nocreateupdate 

/ae-date
Modify appointments if date range ends date. If you do not use the /ae switch, 
the ATA will check all appointments created after the date specified by the /as 
switch. 

The ATA interprets dates on the command line in the [yy]yy/mm/dd format 
unless the /us switch is also included in the command. 

Syntax: 
adjappt J:\develop -1 
/as-98/08/03 /ae-98/08/17 
/nocreateupdate 

/ui-UserID
Modify appointments if sender is UserID. The ATA modifies appointments 
sent only from this user. If this switch is not used, all other qualifying 
appointments will be modified. 

Syntax:
adjappt J:\develop -1 
/cs-98/08/03 
/ui-RFernandez 
/nocreateupdate 
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/us
Use the US date format. This switch signals the ATA to interpret dates on the 
command line using the mm/dd/[yy]yy format. 

Syntax:
adjappt J:\develop -1 
/us/cs-08/03/98 

/nocreateupdate (required)
Do not update the creation time. The ATA modifies the creation date and time 
of every appointment specified unless this switch is used. 

You should always use the /nocreateupdate switch to prevent the ATA from 
setting the appointment�s creation date to the current date and time. This 
switch is not a default, and must be included on the command line.

Syntax:
adjappt J:\develop -1 
/cs-98/08/03 
/nocreateupdate 

/ex-post_office_name
Exclude this single post office from appointment modification. The ATA is 
restricted from modifying appointments sent by users in the designated post 
office to the indicated post office. Only one post office name should be 
specified. 

Syntax:
adjappt J:\develop 
/ex-sales -1 /cs-98/08/03 
/nocreateupdate 

/ex-@path
Exclude the post offices listed in the Host Exclusion File located at path. The 
ATA is restricted from modifying appointments that are sent by users in the 
designated post office to the post offices (that is, the hosts listed in the 
designated text file. This switch is included to allow you to adjust 
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appointments based on the senders� post offices. It is a text file that lists post 
office names separated by commas, <CR><LF>, or simply <LF>.

Syntax:
adjappt J:\develop -1 
/cs-98/08/03 
/ex-@c:\hosts 
/nocreateupdate 
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